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INTRODUCTION 

About this manual 

This manual describes how to use the Twiddlebit Plan project planning tool. This manual is 

specific to Plan running on the Nokia Series 9XXX Communicator (9210, 9210i, 9300 or 

9500). 

The section “Project planning” describes key concepts used throughout this manual and 

should be read before the rest of the manual. Plan is easy to use, provided that the 

fundamental concepts are understood. This manual should be sufficient in order to use Plan, 

however if you are unfamiliar with project planning in general then you may wish to read one 

of the many books available on the subject. 

The “Fast start tutorial” section describes the main features of Plan and provides a quick 

method of getting up to speed with Plan. The rest of the manual contains detailed information 

on all of the features of Plan. 

Screenshots shown within this manual are from Plan running on a Nokia 9500. 

What is Plan? 

Plan is a project planning tool designed for use on a range of handheld and desktop 

computers. It allows an initial project plan to be created and refined and subsequently, when 

the project is underway, provides facilities for tracking progress. 

A project consists of a set of resources, (individuals/groups) who are assigned to specific 

tasks within the project. The project is split into a number of separate tasks. Each task has a 

start and end date, an amount of work, and a number of assigned resources. Dependencies 

may be set between tasks, indicating that a task cannot start until another finishes. In this way 

if one task is updated within Plan, any tasks dependent upon it will be recalculated 

automatically. 

Plan on a Nokia Communicator may be used as a stand-alone project planning tool or may be 

used in conjunction with PC based project planning tools such as Twiddlebit Plan for 

Windows or Microsoft Project. When used with a desktop version of Plan, Plan for the 

Communicator provides an ideal means of transporting project plans out of the office. A 

project plan may be transferred from Plan for Windows on a PC to Plan on the 

Communicator and readily updated “on the move”. The project may subsequently be 

transferred back to the PC upon return to the office. 
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Installation 

Plan may be supplied in various forms: 

1. Pre-installed on an MMC. 

In this case simply insert the MMC into the Communicator and Plan should appear as a new 

application. It will appear as an icon either in the Extras or Desk group. 

2. As a SIS file. 

Use the standard mechanism for installing the SIS file, i.e. one of the following techniques: 

 With the Communicator connected to your PC, use the software provided you’re your 

Communicator to install the SIS file, e.g. double click on the SIS file from Windows 

Explorer to start the install process. 

 Transfer the SIS file to your Communicator and double click on it from the file 

manager to start the installation. 

If updating a previous installation of Plan then simply install the new version as normal – the 

previous version will be detected and removed without removing any created project plans. 

3. As a ZIP file for use with a Nokia 9210/9210i. 

Within the ZIP file you will find a readme file, another ZIP file and a SIS file. 

Install Plan onto the Communicator using the SIS file, as described in 2 above. 

Within the ZIP file there is also a Microsoft Project to Plan converter for use with the Nokia 

9210/9210i. This is supplied as a setup.exe program which is contained within the 

PlanCnv.zip. Running the setup.exe will install an additional software component on your PC 

into the "PC Suite 2.11 for Nokia Communicator" product supplied with a Nokia 9210/9210i 

Communicator.  

With this converter installed you can drag Microsoft Project files to your 9210/9210i 

Communicator using Windows Explorer and they will be converted into Plan format 

automatically. Please note the following points concerning the use of this optional PC based 

converter: 

 You must have the Nokia PC Suite 2.11 installed on your PC. It will not work with 

other versions of the Nokia PC Suite, such as the version compatible with the Nokia 

9300 or 9500. If you have a 9300 or 9500 check out the Twiddlebit “Plan for 

Windows” which is the desktop PC version of Plan. 

 MPP, MPD and MPX files can be copied and converted by dragging them to your 

Communicator using Windows Explorer. For MPX files you will need to select to 

convert them into Plan format rather than Word format. 

 You cannot convert Plan files to Microsoft Project format by dragging Plan files from 

your Communicator back to your PC. You must use the "Save as MPX" option within 

Plan instead, and then copy the MPX file to your PC. 
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Purchase Options 

Plan is shareware, which means that if you continue to use it you should register with 

Twiddlebit. The software may be freely distributed provided all files in the package are 

included. The freely available trial version is fully functional but will be limited in one of two 

ways: 

1. A maximum of 10 tasks may be entered until the software is registered by entering a 

special code via the register menu option. 

2. If the version of Plan provided is integrated with the Openbit License Manager then it 

will be either time limited or may only be run a given number of times. 

When you purchase a license the software will be fully enabled. This will remove any limit 

applying to the unregistered version.  

Purchase via the Internet 

If you have access to the Internet then the fastest and easiest method to register is via a credit 

card, online. To do this, follow the links from the purchase section of the Twiddlebit web 

site: 

 http://www.twiddlebit.com 

Purchase via voice call 

Credit card orders can also be taken by telephone as follows. Within the USA: 

 Call: 1-877-REGSOFT (734-7638) 

 Fax: 1-800-886-6030 

Elsewhere: 

 Call: (USA code) 770-319-2718 

 Fax: 1-208-279-3837 (or 0870-132-2485 if within UK) 

When registering using RegSoft by phone or fax you MUST quote the RegSoft Product ID 

shown below: 

Plan for Nokia 9XXX RegSoft Product ID: 40941 

Purchase via Openbit License Manager 

If the version of Plan provided is integrated with the Openbit License manager an initial 

warning will be displayed when you start Plan for the first time. This will indicate the 

software is operating in trial mode and will indicate the terms of the trial (time limited or a 

limit as to how many times the application may be started). When the trial period is over you 

will be prompted to purchase a license. 

Licenses may be purchased be selecting the appropriate options in the Openbit License 

manager which appears when you start the application. Payment options may include: 

 payment via your phone bill, 

 payment via a credit card, 

 an option to enter a license key. 

Follow the prompts to select the appropriate payment method and price. 

Purchase via post 

If you wish to register by post, then you can send a cheque for £11 (must be from a UK bank) 

made payable to "Twiddlebit Software" to: 

http://www.twiddlebit.com/
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Twiddlebit Software, 

23 Worcester Avenue, 

Hardwick, 

Cambridgeshire. CB23 7XG. 

U.K. 

We cannot accept non-UK cheques at the above address. When registering via post it is 

important to state the following: 

 Which product you are registering, i.e. “Plan for Nokia 9XXX”. 

 If you have an e-mail address please quote this in order to receive the registration 

code via e-mail more quickly. 
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PROJECT PLANNING 

Fundamental concepts 

Plan allows a project plan to be constructed from individual task components. Task and 

resource details are entered into the application along with dependencies between tasks. The 

application will then calculate the schedule for each task and the project as a whole. 

Each task within a project plan has the following key values: 

 start date and time, 

 end date and time, 

 the amount of work required to complete the task, 

 a number of assigned resources working at a given rate. 

A number of resources may be assigned with given work rates to each task. The resource 

work hours, holiday information and work rates are then taken into consideration when 

calculating task values, such as end dates. 

An “Input” option for each task (which appears under the “Details” tab when editing each 

task) allows control over which of the above values are entered manually and which are 

calculated by Plan. This field can take one of 3 values: 

 “Work & rates”. Here you enter the work and resource rates and Plan calculates the 

start/end date. 

 “Rates & dates”. Here you enter the start and end along with resource work rates and 

Plan calculates the work required by each resource and the task as a whole. 

 “Work & dates”. Here you enter the start and end along with the work each resource 

performs on the task and Plan calculates the work rate for each resource. 

When considering which of the above options to select for a task, it is often associated with 

the stage the task is at: 

 For planned tasks you usually can estimate the work and rates and want Plan to 

calculate the end date (use the “Work & rates” option). 

 For tasks nearing completion it is sometimes easier to estimate when the task will 

finish, so you enter the rates and dates and get Plan to calculate the work  (use the 

“Rates & dates” option).  

 For tasks which are completed, you know when the task started and finished and can 

sometime enter the total work (from timesheets), so Plan will calculate the average 

resource work rates (use the “Work & dates” option). 

In addition to the above, constraints can be set for each task: 

 Known start/end dates can be input manually (via the “Constraint” option under the 

“Details” tab when editing a task). The start or end can be constrained in various ways 

– fixed absolutely or set to be before or after a given date. 

 A number of dependencies can be defined upon other tasks, e.g. a task must start after 

another task finishes. 
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Example 

Consider a task which is estimated to take two man days to complete, (one man day being the 

time between the start and end of a normal working day, set to 8.0 hours in this particular 

example). A resource is assigned to the task where the resource has the following attributes: 

 Works from 8:00am until 5:00pm with an hour for lunch at noon. 

 Works a standard week starting on Monday and ending on Friday. 

The task start day is set to a Monday at 9:00am and the work set to two days. Plan calculates 

the end of the task to be 5:00pm on Tuesday. Assume now that the resource is only available 

to work on the task at a rate of 50% rather than 100%. Plan would now indicate the end of the 

task to be Thursday at 5:00pm. Assume also that the resource takes one day holiday on 

Tuesday. Plan would calculate the end to be Friday at 5:00pm. Suppose that the task is 

completed and actually finished at 5:00pm on Wednesday rather than 5:00pm on Friday. Plan 

will allow the end time to be set to the actual end time and will then calculate the work given 

the start, end and resource details to be one man day rather than two. 

Plan works internally down to an accuracy of one minute. 

Calculation of task dates 

The start of any task is controlled either by dependencies defined on earlier tasks, constraints 

on the start/end date, or a combination of the two. 

Dependencies may be set between tasks so that the start of one task depends upon the end of 

another. If the first task is delayed the second will also be delayed. Dependencies may be set 

for a number of reasons, such as: 

 If one task cannot logically start until another task finishes. For example, in a software 

development project the development may be dependent upon the requirements phase. 

 Resource limitations may impose dependencies, for example if two tasks need to be 

carried out by one person, and the person works on the tasks sequentially, then a 

dependency should be set between the tasks. 

When creating a task a constraint on the start date may be set to indicate either that the task 

should start on the specified date or cannot start before the given date. If no dependencies 

have been defined then the given date will be used as the start date for the task. If the task has 

one or more dependencies upon earlier tasks then the latest date will be used as the task start 

date, taking into consideration all the dependencies and the specified start on/after date. 

The plan has a “Calculate from start/end date” associated with it, which is set via the “Plan > 

Calculation/Storage…” menu option. The default is that a project start date is entered and 

tasks will be calculated from this date forwards in time to determine the project end date. 

Alternatively a project target end date can entered and Plan will calculate back in time to 

determine when the tasks need to start in order to meet the target end date. 

Tasks have various start/end date fields: 

 Start/end. The calculated start/end dates. 

 Early start/end. The earliest date the task can be started/finished. 

 Late start/end. The latest date the task starts/finishes in order not to delay the project. 

 Saved start/end. You can take a copy of the start/end date values for later reference 

(termed a “baseline”). This is usually used to record the initially estimated plan so that 

you can compare the actual start/end dates as they are determined. 
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FAST START TUTORIAL 

This section describes, by way of an example, how to use the main features within Plan. It 

includes an example of creating a plan, adding resources and tasks, and updating tasks. 

Plan has many features and it is not possible to describe all of these features within a short 

section such as this. This section includes enough to get you started, as you become more 

familiar you may want to explore the rest of the manual to find out what else you can do with 

Plan. 

Creating a new plan 

If Plan has not been installed then refer to the installation section before proceeding. 

Ensure that you start this tutorial with a new empty plan file. To do this simply start Plan. 

When you start Plan a new empty plan will be shown. 

When creating a new file, Plan will create a plan containing a single default resource called 

“Standard”. The working days for this resource will be set to default values. The following 

tutorial assumes that the working days are Monday to Friday with Saturday and Sunday as 

non-working days.  

Plan will start up and display a Gantt view. This is one of the many different views available 

within Plan. 

Creating a new resource 

Start by creating a new resource. 

To do this, select the “Resource > New resource…” menu option. 

Enter the initials and full name for the resource as “Res1”. Leave the other fields unchanged, 

unless stated otherwise below. The maximum units value will default to 1, indicating that this 

resource represents a single person. A resource may be used to represent a group by setting 

the maximum units to a value greater than 1. Set the charge per hour to 5. Plan will calculate 

the cost of the project using the resource charge rates as entered here. 

Note that the “Default work hours” tab shows the hours this resource works. Leave these at 

the default of 8am to 5pm with 1 hour lunch break throughout the whole week, Monday-

Friday. Press “Close” and the resource will be created. 

From the “View” menu select the “Change view > Holidays” option. This displays the 

holidays for each resource. Use the TAB or SHIFT-TAB keys to view the holidays for the 

“Res1” resource. These will have defaulted to the same holidays as the Standard resource 

when the resource was created. The cursor keys may be used to move from one day to the 

next. Pressing the enter key on a day in the holiday view toggles a day from a work to a 

holiday and vice versa. Leave all the holidays unchanged for the time being. 
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Creating tasks 

Now enter a new task. From the “View > Change view” menu select the “Task List” menu 

option. 

Press the enter key, or select the “New Task” key next to the screen. A dialog will appear 

prompting for the task details. Enter the values as shown: 

 Description: Task 1 

 Total Work: 3 days 

With the “Resources” tab selected, use the “Add resource” button to assign a resource to the 

task: 

 Resource:  Res 1 

 Rate:   100% 

Select “Close” to create the new task and display the task list view. 

The new task will be created and the screen will update to show the entered and calculated 

values. Note that the start and end date for the task has been calculated by Plan using the 

project start date and the work for the task. 

Select the “Plan > Calculation/Storage…” menu and change the project start date to 12:00am 

03 Nov 2003. The end for Task 1 should be recalculated and displayed as 5th Nov. 

From the “View > Change view” menu select the “Gantt view”. Press the space bar which 

will refresh the display on the right hand side to display the current task. This shows the task 

on one line with a graphical representation of the task on the right hand side of the screen. 

Press the down arrow to move the highlighted line, or cursor, to below task 1. 

Using the “New Task…” menu option, create a new task with the following values: 

 Task Name: Task 2 

 Work:   1 day 

 Resource:  Res1 

 Rate (%):  100 

The new task will be shown below task 1 and will be shown as starting on the 3rd Nov and 

ending at the end of the same day. 

Setting dependencies 

Now set the start of task 2 to depend upon the end of task 1. With task 2 current, i.e. 

highlighted, edit the task by pressing the enter key and select the “Dependencies” tab. Use the 

“Add depend.” button with the following settings: 

 Type:  Start after 

 Task:  1 Task 1 

 Lag:  0days 

When the “Close” is pressed task 2 will be recalculated to start after task 1. 

To manipulate the Gantt chart display press the Tab key to switch from the left hand side of 

the display to the right. The Tab key can be used to switch alternately between the two sides 

of the display in the Gantt view. With the right Gantt section selected the left and right cursor 

keys can be used to scroll the time axis left and right and the zoom menu option to alter the 

scale on the time axis. 
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Summary tasks 

Now enter a summary task for tasks 1 and 2. 

Ensure that task 1 is current and press shift-enter to insert a new task. The enter key edits the 

current task, or creates a new task if no task is current, and shift-enter inserts a new task 

immediately above the current task. Set the description to “Summary task”. Leave all the 

other fields unchanged. A new task will be inserted at the top of the list. 

At the moment all the tasks are normal tasks and we need to make task 1 and 2 sub-tasks of 

the new task. To do this, make task 1 current and press the > key (you will need to use the 

shift key for this). This will indent task 1. The < key could be used to un-indent a task. 

Task 1 is now a sub-task and the summary task has been changed from a normal task into a 

summary task. Repeat this so that task 2 is also a sub-task.  

The view below should be shown. 

 

Updating a task 

To demonstrate how Plan automatically recalculates tasks, edit task 1 so that the work is 

5days. This is done by making task 1 current and pressing enter. When edited, task 1, 2 and 

the summary task will be recalculated automatically. 

Sample Plan 

A sample project plan (PlanSample.pln) will be installed with Plan to the Documents folder 

which can be used to experiment with Plan’s features. 

Transferring data between Plan and your desktop PC 

Plan for Windows 

There is a companion desktop PC version of Plan called “Plan for Windows”. You can use 

Plan for Windows on your desktop PC and transfer these files to/from your Communicator 

for use with Plan. The desktop and the Communicator versions both share the same PLN file 

format. 

The desktop “Plan for Windows” can also directly read and write Microsoft Project files. 

MPP, MPD and MPX files may be opened and saved into Plan format. Plan files may also be 

converted back to Microsoft Project MPD or MPX format. Therefore the desktop version can 

be used as a means to convert between Microsoft Project and PLN format for use with the 

Communicator version of Plan. 

Optional Nokia PC Suite Plug-in 

Twiddlebit provide an optional PC based converter. This converter integrates with the Nokia 

PC Suite 2.11 for 9210/9210i. Using this, Microsoft Project MPP, MPD and MPX files can 
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be converted automatically when dragged/dropped to the Communicator via Windows 

Explorer. 

Note: The Nokia PC Suite 2.11 and the above converter are only compatible with the 

9210/9210i, not the 9300 or 9500. 

MPX file format 

Plan on the Communicator can also directly read and write Microsoft Project MPX files. To 

create an MPX file use the “File > Save > Save as MPX” option. 

If making changes to an opened MPX file they will be saved back into a new Plan format file 

with a PLN extension. 

Microsoft Project versions up to an including 98 may save or open MPX files. Note that with 

Microsoft Project 2000 and later versions the ability to save as MPX was removed (though 

you MPX files may still be opened). 
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KEY FEATURES 

Plan has the following key features: 

 A separate file for each project plan with either plan specific or a shared resource file. 

 Any number of tasks may be entered (subject to available memory), each having the 

following details: 

 task name/description 

 start date and time 

 end date and time 

 work 

 any number of assigned resources per task 

 rate of work or work value for each assigned resource 

 any number of dependencies upon other tasks 

 calculation method (end, work or rate) 

 constraint on start/end (start after, finish before,…) 

 work done (% or work value) 

 baseline work, start and end dates and times for future reference  

 general notes 

 labour and fixed costs 

 text1 - text5 fields 

 number1 - number5 fields 

 Calculation of end date and time, work, or work rates for each task. 

 A start or end constraint may be specified for each task, i.e. the task must start on/after the 

given date. 

 A task may be dependent upon any number of other tasks, with specified lag times with 

each dependency. Plan will automatically calculate the start of each task from the 

dependencies and constraints. 

 Task tracking. The actual work done may be input as work progresses. 

 Accuracy down to a minute. 

 Tasks may be grouped under a summary task whose fields are calculated automatically 

from the sub-tasks. Tasks may be nested up to eight levels deep. 

 The labour costs are calculated automatically for a task along with the total cost for the 

project. 

 Any number of resources may be input, (subject to memory limits imposed by the 

operating system). Each resource has the following properties: 

 initials 

 full name 

 maximum units available 

 labour charge per hour 

 charge per use 
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 flexible repeating work shift pattern, e.g. standard start/end work hours Mon-Fri 

repeating every 7 days 

 override work hours for any day 

 set holidays on a per day basis 

 text1 - text5 fields 

 number1 - number5 fields 

 A Gantt chart view. 

 Sorting of tasks by a number of attributes. 

 Transfer projects between the Communicator version of Plan and the desktop version 

(Plan for Windows) or Microsoft Project. 

 Can directly read and write Microsoft Project files (MPX). Microsoft Project 

98/2000/2002/2003 MPP and MPD files can also be read via the supplied PC based 

converter. 



Plan User Manual 

Page 14 of 22 

VIEWS 

Plan supports the following views, all accessible from the “View > Change view” menu 

option: 

 Task list 

 Gantt view 

 Resource list 

 Holidays 

The first two views show tasks using different display formats. The resource view shows the 

list of resource available. The holiday view shows resource holidays for a single selected 

resource.  

In the task views many of the same keys have the same function, for example the up and 

down cursor keys change the current task and the enter key edits the current task. In each of 

these views the current task will be highlighted. 

As well as selecting a view from the menu you can also cycle through the views using the 

Ctrl-Q key combination. 

Task list view 

The task list view shows the following fields for each task: 

 Description. Textual description of the task. 

 Start. Calculated start date 

 End. Calculated end date 

 Work. Man hours work value 

 Resources. Resources assigned to the task 

 Dependencies. Other tasks this task depends upon to start/finish 

 % done. Percentage of work completed. 

 Saved work, start & end. Recorded/baselined work/start/end values 

 Early start & end. Earliest dates task can start and end 

 Late start & end. Latest dates task can start/end without delaying the final plan end date 

 Res. cost. Costs associated with the resource labour costs 

 Fixed cost. A fixed cost which can be entered for the task 

 Total cost. Total cost of the task 

 W.B.S. Work Breakdown Structure code – a unique identifier for the task 

 Note. Freeform note associated with the task 

 Text1 – Text5. Freeform text associated with the task 

 Number1 – Number5. Freeform values associated with the task 

In the task list view and Gantt view each task is shown on a separate line of the display. One 

of the tasks on the screen will be highlighted and is referred to as the current task. Pressing 

the up and down arrow keys changes the current task. If there are more tasks than will fit onto 

the screen then when at the top or bottom of the screen pressing the cursor key will scroll the 

screen vertically to display the next task off the screen. Use the Ctrl or Chr keys with the 
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cursor keys to scroll the display a page at a time. Use the left and right cursor keys to scroll 

the view left and right. 

The task description will be indented to indicate the level of a task in the hierarchy of 

summary and sub-tasks (see “Summary and sub-tasks” section of this manual). 

Use the zoom options on the View menu to control the font size of the task list, Gantt and 

resource views. 

Gantt view 

The Gantt view shows the same information on the left of the screen as the task list view. On 

the right of the display a Gantt chart is shown. This chart shows a time axis at the top of the 

screen with a bar for each task, indicating the duration of the task. The current date will be 

shown as a dotted vertical line through the chart. 

The up and down cursor keys may be used, as in the task list view, to change the current task 

and to scroll the screen up or down. Use the Tab key to switch focus between the left and 

right sides of the display. With the left side in focus the left/right cursor keys and zoom menu 

option scroll the table left/right and effect the font size. With the right side in focus the cursor 

and zoom options effect the Gantt display. 

Depending upon the zoom factor the time axis may show the years, months, weeks, days or 

hours. There is a maximum and minimum limit by which the display can be zoomed in or out 

in this way. 

If the space key is pressed the zoom factor and display will be altered to best display the 

current task. 

There are a number of preference settings controlling the appearance of the Gantt chart. One 

option controls whether one or two bars are displayed for each task (“Saved bars in Gantt” 

setting). If two bars are displayed then the lower bar indicates the start and end dates from the 

saved fields. The saved start and end fields should normally be set when the original project 

plan has been established and may be used to compare the original planned dates with the 

latest calculated dates. 

Depending upon the preference setting “Gantt holiday shading” the holidays associated with 

each resource may or may not be shown on the Gantt chart at various scales. For fast shading 

ensure that the “Standard resource” setting rather than “Resource specific”. 

Task fields (resources, start, end,...) may optionally be displayed to the left or right of each 

task bar in the Gantt chart. The field to be displayed is controlled from the “Gantt text…” 

options in the preferences dialog. 

Resource view 

The resource view shows the following fields for each resource: 

 Initials. Abbreviated resource name (8 characters max.) which is used for display and 

selection in views and dialogs. This must be unique. 

 Full name. Long resource name. 

 Max units. Number of individuals the resource represents, use 1 to represent a single 

person, a value greater than one to represent a pool or group of resources. 

 Email. Email address for the resource. This is used for reference purposes only. 

 Group. Group resource belongs to. This is used for reference purposes only. 

 Code. A code associated with the resource. This is used for reference purposes only. 

 Charge/h. The cost of the resource per hour of work done. Used in calculating task costs. 
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 Charge/use. The fixed cost of the resource for each resource assignment. This is a one 

off cost per task the resource is assigned to regardless of task duration. 

 Text1 – Text5. Freeform text associated with the resource 

 Number1 – Number5. Freeform values associated with the resource 

 Note. Freeform note associated with the resource. 

In the resource view each resource is shown on a separate line of the display. One of the 

resources on the screen will be highlighted and is referred to as the current resource. Pressing 

the up and down arrow keys changes the current resource.  If there are more resources than 

will fit onto the screen then when at the top or bottom of the screen pressing the cursor key 

will scroll the screen vertically to display the next task off the screen. Use the Ctrl or Chr 

keys with the cursor keys to scroll the display a page at a time. Use the left and right cursor 

keys to scroll the view left and right. 

Use the zoom options on the View menu to control the font size of the resource, task list and 

Gantt views. 

Holiday view 

The resource holiday view displays a full year view indicating the holidays for the current 

resource. Holidays are indicated by a grey filled square. When calculating task end times or 

work, a resources holidays will be taken into consideration. 

The cursor keys may be used to move the cursor from one day to the next.  Combining the 

left and right cursor keys with the Ctrl key will move the cursor a week at a time. Using the 

Ctrl key with the up and down keys will move to the previous or next year. 

Use the Tab key to quickly cycle through the available resources. Shift-Tab cycles in the 

reverse direction. 

Pressing the enter key will toggle the day on which the cursor is positioned from a holiday to 

a work day and vice versa. 

The first resource in the resource view (called Standard) represents a default resource which 

cannot be deleted. When creating new resources the work hours and holiday settings are 

copied from the standard resource. 

Work hours for the current selected day are shown at the bottom of the screen. These will 

default to the work hours set in the “Default work hours” tab of the resource dialog. A 

repeating pattern is set for the hours such as given hours Mon-Fri with Sat/Sun as rest days. 

The default work hours on an individual day can be overridden using the Edit hours button. 
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TASKS 

Editing tasks 

To create a new task position the highlighted area at the bottom of the task list or Gantt chart 

view and press enter, or use shift-enter to insert a new task above the current position in any 

of the task based views. Pressing enter with the cursor positioned on an existing task allows 

the given tasks details to be altered. 

When entering or editing tasks a dialog box will appear which allows the following items to 

be set: 

Details: 

 Description. A description of the task, up to 255 characters long. 

 Constraint. This field allows an additional constraint to be placed on the task start/end 

dates. The default is “As soon as possible” whereby Plan will set the start/end dates to the 

earliest value possible taking into consideration any dependencies. The options prefixed 

with the word “Fixed” allow the start or end date to be fixed absolutely. In this case no 

dependencies may be set for the task. The last four options, postfixed with “…” allow a 

constraint date to be entered in the following “Constraint date” field. 

 Constraint date. See above description of the “Constraint” field. 

 Input. This field may be set to “Work&rates” (the default), “Rates&dates” or 

“Work&dates”. The setting controls which of the start/end dates, work and resource work 

rates are entered. Two of these three parameters are entered and the third is calculated. 

 Start and End. The date and time the task starts and ends. Depending upon the “Input” 

field setting this field may be greyed out. The fields can only be set if the Input field is set 

to “Rates&Dates” or “Work&dates”. When entering the start and end dates the values are 

used to calculate the work per resource or each resource work rate. If dependencies or a 

constraint are also set then the start/end dates may subsequently be recalculated to meet 

the conditions, regardless of the entered start/end date. 

 Work. The work for the task is specified in days, hours, and minutes, (the length of one 

work day is given in the plan properties settings). This item may or may not appear 

according to the “Input” field. 

Resources: 

 Resources. This tab of the task dialog displays the resources assigned to the task. 

Resources may be added or removed from the task or existing assignments can be edited. 

When editing resource assignments the resource name and a percentage are entered. A 

percentage of 100% would indicate, for example, one resource working on the task 100% 

of the time, 200% could indicate a resource consisting of two people each working 100% 

of the time on the task. 

Dependencies: 

 Dependencies. This tab of the task dialog displays the dependencies of the task upon 

other tasks. Dependencies may be added or removed from the task or existing ones can be 

edited. When editing dependencies a type may be entered (Start after, Start with or after, 

Finish with or before, or Finish before) which indicates in what way the start or end 

depends upon the other task. Along with the task name a lag value may be entered. The 

lag offsets the dependency by the given amount. A positive or negative value may be used 

to shift the dependency forwards or backwards in time. 

Tracking: 
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 Target. This value is shown for reference and cannot be altered. It shows how much of 

the task should be complete at the current point in time for comparison against the 

“Actual % done” field. 

 Actual % done. This field shows the actual percentage of the task completed. Note that 

“Tracking” field in the “Plan > Properties” dialog controls whether actual values are 

entered as a % of the planned work or as actual work done values in days and hours. 

 To start of. This field allows a date to be entered which indicates when the “Actual % 

done” field was last updated with information. 

Custom Fields: 

 Text1 – Text5. Freeform text associated with the task. 

 Number1 – Number5. Freeform values associated with the task. 

Costs/Notes: 

 Include labour costs. If ticked (the default) then resource costs are included in the costs 

for the task. If not ticked then any resource costs are ignored. 

 Fixed cost. A fixed additional cost associated with the given task. 

 Number. A freeform field accepting any numeric value. 

 Notes. A freeform field usable for general notes associated with the task. 

Task costs are displayed in the task list and gantt views. 

The “Plan > Plan summary” menu option may be used to display total costs for the project. 

Summary and sub-tasks 

A summary task is a task providing an overview of a number of sub-tasks.  The majority of 

the data associated with the summary task is calculated by Plan from the data associated with 

each sub-task. The description, dependencies, notes and number fields are the only fields that 

may be entered manually for summary tasks. 

The start of the summary task will be equal to the earliest sub-task start date and the end will 

be equal to the latest sub-task end date. The work and cost fields will be the sum of the 

corresponding sub-task fields. The % done field will be the % of the work done so far on all 

the tasks. 

Summary tasks may be nested so that a summary task may also be a sub-task of a higher level 

summary task.  There may be up to eight levels from the outer most summary task to the 

lowest sub-task. The level of a task is indicated using indentation within the task list and 

Gantt chart views. 

To alter a tasks level use the < and > keys (these keys are the same as the zoom keys and will 

need to be used in conjunction with the shift key), e.g. press > to make the task a sub-task of 

the task immediately above it. It is a good idea to turn automatic calculation off in the 

preference settings before making major changes to task levels. It is also recommended that 

the basic structure of a project should be established in terms of summary tasks and sub-tasks 

before assigning dependencies. 

If a summary task is highlighted then the “Show/hide subtasks” menu option on the “Task” 

menu may be used to show or hide tasks below the given summary task. The minus symbol 

next to the description will change to a plus and vice versa to indicate if sub tasks are shown. 

The + key may be used as an alternative shortcut for showing/hiding subtasks. 

In the example plan supplied, the tasks have been grouped into various phases using 

summary tasks. 
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Sorting tasks 

The “Plan > Sort tasks…” menu option may be used to sort the tasks in the task and gantt 

views by given task fields. 

Baselines (saved work/start/end date) 

Each task has a saved work/start/end date. This can be used to store a baseline for the task. A 

baseline records the calculated work/start/end date at a particular point of a project plans life. 

It is often useful to save a baseline when initially constructing a plan so that it can be 

compared at a later date when the plan is in progress. 

The “Plan > Baseline…” menu option is used to copy the work/start/end dates into the 

baseline saved work/start/end date fields. This menu provides options for selecting which 

tasks the saved fields are updated. Just the currently selected task(s) may be updated, all new 

tasks (those where the saved fields are set to 0), any where the start date is in the future, all 

tasks in the plan. 
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RESOURCES 

Plan allows any number of resources to be created, subject to available memory. Each 

resource has a repeating pattern of work hours. Normally this pattern repeats weekly, but any 

pattern can be defined with a given number of days for each cycle in the pattern. Holidays 

and work hours for individual days can be overridden for each resource as required. 

By default when first using Plan only one resource will be available called “Standard”. This 

will be constructed using the following rules: 

 The work days for the resource are set as Monday to Friday, repeating weekly. 

 The default work hours are set to 8am-12pm and 1pm-5pm. 

When creating additional resources the work hours and settings are copied from the 

“Standard” resource. Consequently it will save time by setting common work hours and 

public holidays in the “Standard” resource before creating any additional resources. 

The holidays set for the “Standard” resource should be common public or bank holidays. The 

“Standard” resource is used when calculating tasks where no resources have been assigned. 

In this case the assumption is that a single standard resource works on the task. This resource 

is also used when calculating dependencies where a lag value is entered. 

To create a new resource use the “New resource…” menu option from the “Resource” menu. 

This will prompt for a resource initials, which must be unique. To delete a resource, ensure 

that it is selected in the resource view and press the delete key. Any existing tasks using the 

resource will be updated to remove any resource assignments associated with the resource. 

Note that you cannot delete the “Standard” resource. 

Each resource has the following fields: 

Details: 

 Initials. Abbreviated resource name (8 characters max.) which is used for display and 

selection in views and dialogs. 

 Full name. Long resource name. 

 Email. Email address for the resource. This is used for reference purposes only. 

 Group. Group resource belongs to. This is used for reference purposes only. 

 Code. A code associated with the resource. This is used for reference purposes only. 

 Max units. Number of individuals the resource represents, use 1 to represent a single 

person, a value greater than one to represent a pool or group of resources. 

 Charge/h. The cost of the resource per hour of work done. Used in calculating task costs. 

 Charge/use. The fixed cost of the resource for each resource assignment. This is a one 

off cost per task the resource is assigned to regardless of task duration. 

Default work hours: 

 Repeat the following pattern every. The work hours displayed in the list are repeated in 

a regular pattern which cycles by the number days entered into this field. Usually this is 7 

to represent a pattern which repeats weekly. 

 Work hours. The working hours for the resource. 

Custom Fields: 

 Text1 – Text5. Freeform text associated with the resource. 

 Number1 – Number5. Freeform values associated with the resource. 
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Notes: 

 User notes. Freeform note associated with the resource. 
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CALCULATION SETTINGS AND PREFERENCES 

Calculation/Storage Settings 

 Calculation. May be set to “Automatic” or “Manual”. With the automatic setting 

whenever a change is made all effected tasks are recalculated. With the manual option the 

“Plan > Recalculate all” menu option must be used to recalculate all tasks when needed. 

 Calculate from. A project can be calculated in one of two ways – you specify a start date 

and plan will schedule from this date to determine the project end date. Alternatively you 

can enter an end date and Plan will determine when each task needs to start in order to 

complete the project by the given date. 

 Average work day. The average work day option defines the duration of one normal 

work day.  This unit of work is used when entering work values. Typically this should be 

set to the length of an average working day, excluding any breaks. 

 Work days per week. The number of working days in an average week. This is used 

when displaying week values. 

 Tracking. May be set to “by %” or “by time”. With the percentage option actual work 

done is entered as a percentage of the work planned. The “by time” option allows work 

done to be entered in actual days and hours. 

 Resource storage. Resources may be stored within the plan along with task details or 

may be stored centrally. Central storage allows resource data to be shared between 

separate project plans. Note that when using the shared option, only edit resource details 

in a single plan at a time. Also be aware that with the shared storage if you send a plan to 

another person the resource details will be missing from the plan file. 

Plan application Preferences 

 Task description. Controls the width of the task description column as a % of the 

default. Increase this if descriptions for tasks are long. 

 Date format. Controls the date format used to display dates. 

 Gantt holiday shading. This option controls the shading of holidays in the Gantt chart. If 

set to “Resource specific” any non-working days will be shaded grey for the particular 

resource the task is allocated to. The “Standard” resource will be used if multiple 

resources are assigned to one task. If set to “Use standard” then all shading will use the 

holidays for the “Standard” resource. The later option will result in much faster redraws 

of the Gantt chart. 

 Dependencies in Gantt. Controls whether dependency lines are drawn between tasks in 

the Gantt chart view. 

 Saved bars in Gantt. If set to “Yes”, two bars are drawn for each task. The top bar 

depicts the calculated start/end dates and the bottom bar represents the saved start/end 

dates. 

The Gantt text button displays a dialog which controls the text that is displays at the ends of 

the task bars in the Gantt chart. Text can be displayed to the left and right of each task. It is 

also possible to display different text for normal tasks, summary tasks and milestone tasks. 

The Gantt colours option allows the colours used by Plan to be altered. 
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